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IBACKGROUND INFORMATION~ - :0
As commander of the nuclear-powered sub, Red October (RO), you're in
charge of one of the most powerful weapons on earth - difficult to
detect, swift to strike.

You've been entrusted to test the latest in Soviet naval technology: a
revolutionary "Caterpillar" Drive that will make the RO practically
undetectable. Unfortunately for Mother Russia, they've trusted the
wrong man. You plan to defect to the US and hand over the Reds' new
technology.

You've hand-picked your officers, men who will risk their lives for your
plan. The enlisted men suspect nothing and this mustn't change. Your
mission orders (faked, of course) will help keep your crew in the dark.

The defection starts in the Reykjanes Ridge (affectionately renamed
"Gorshkov's Railroad" after Admiral Gorshkov). Along the Ridge are
Russian surface vessels and subs, not to mention US attack subs, and a
complete underwater listening network, all with the sole purpose of pre
venting boats like the Red October from slipping through to the open sea.

You've sent a taped confession to your Admiral telling him why you've
stolen the RO. The Soviets won't be sympathetic. All Soviet spy
trawlers are on the look out for you; they will hunt you across the entire
Atlantic. Three fleets will chase your boat down and try to recapture or
destroy her. Soviet subs will position off the major US military and
commercial ports to block your entry.

You've also sent a message to the U. S. Navy telling them you'll deliver
the Red October to them in exchange for political asylum. They hope
you're telling the truth; but, since you're the enemy, they'll also be on
guard. In other words, they'll b~ ready to help you defect or to blow you
out of the water.

The defection plan is cunning. Your engineering officer fakes a leak in
the nuclear reactor. Radiation! The boat must be abandoned! A
"convienent" American vessel is on hand to rescue your crew. The RO
will be scuttled and the world will believe that the pride of the Soviet
fleet has been destroyed instead of falling into capitalist hands. But it
won't be true. Through nautical slight-of-hand, the US Navy will sink an
old sub in place of the RO and steal away with the Soviet boat.
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After the game loads, you see the High Level Command Screen and a
cursor in the shape of an arrow and sickle.

Use the Mouse (Amiga and ST), Joystick (Commodore 64; MS DOS
machines), or Cursor Keys (MS DOS machines) to control the cursor.
Press the left Mouse button, Joystick fire button, or the SPACEBAR to
accept options the cursor is moved to. Throughout these instructions,
we'll refer to this process as "clicking" on a selection. Sometimes we tell
you to "double-click"; this means to click twice, quickly.

Note to C-64/128 users: To play using the Keyboard, use these keys for
movement: 1=UP; f-=DOWN; CT RL=LEFT; 2=RIGHT. Use the
SPACEBAR instead of the joystick fire button.

Note to Tandy MS-DOS users: To play using the Keyboard, ignore the
arrow cursor keys and use the numeric keypad for movement: 8=up;
2=DOWN; 4=LEFT; 6=RIGHT.

The Hunt for Red October lets you save games to disk, reload them for
later play, and do a number of other functions, depending on your
computer type and memory.

TANDY 1000SXl1000EX MACHINES
To play The Hunt for Red October with a Joystick:

o Turn off the computer and connect Joystick to the left port.
o Load MS-DOS (version 2.1 or later) and press F4 for MODE

SLOW.
o After loading the game, remove Joystick from the left port

and connect it to the right port.

INSTALLING ON A HARD DISK
To install The Hunt for Red October on your hard disk:

o Boot your computer from the hard disk.
o When you see C>, type MKDIR HFRO and press .J.
o Then type CD HFRO and press .J.

• Place the game disk in drive Aand type COpyA:"'. "'C:
and press.J. The game is now installed on your hard disk.

To run The Hunt for Red October from your hard disk:

o At the C> prompt, type CD HFRO and press .J.
o Then type HFRO and press.J. The game loads.

ILOADING THE GRME~ _ e

The Hunt for Red October is designed for the Amiga 500, Amiga 1000,
Amiga 2000, Atari 520ST, Atari 1040ST, Commodore 64/128, and MS
DOS machines (IBM and compatibles, 512K minimum memory).

Before loading the game, format a blank disk to use as a save-game disk
(refer to your computer user's' manual for for~atting instructions).

Rmiga
Turn on your computer and monitor. Insert the game disk at the
Workbench™ prompt and the game loads autom.atically.

Rtari SI
Insert game disk, turn on computer, and double-elick on the HFRC,.P~G

icon. The game loads and a Menu Bar appears at the top of the title
screen. Move the cursor to the File Menu, slide it down until CONTINUE
GAME is highlighted, and press the left Mouse button. This loads the
game at the starting position and you're ready to play.

Commodore 64/128
Connect a Joystick to either port. Turn on your TV or monitor, disk
drive, and computer (with C-128, hold down the Commodore key
while turning on the computer). Insert game disk into drive and close
the door. Type LOAD" "''' ,8,1 and press IR~turn'. You'll hear a high
pitched tone and see colorful horizontal lines on he screen as the
game loads.

Note: If you have trouble loading the game, disconnect any
peripherals other than the disk drive and try again.

MS-DOS Machines
Connect a Joystick, if desired. Load MS-DOS (version 2.1 or later)
and insert game disk into any drive. At the> prompt, type HFRO and
press.J. Then, select whether you're using a CGA or EGA
graphics card, press .J, and the game loads.

After the title screen loads, the Menu window appears. Press the
SPACEBAR and you're ready to play. Before beginning the game,
however, save the starting position on your save-game disk
(selection 4 on the Menu). This way, if you want to abandon a
game you're playing and start over (or if your sub gets sunk), just
load the start position game you saved. If you don't save the start
position, you'll have to re-boot the game to start a new one.

IPLAYER OPTIONS~ - e
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amiga
AMenu Bar lets you make gameplay selections with the Mouse. To
see the Menu Bar, hold down the right Mouse button. To make a
selection, place the cursor over the Menu you want (Project, Help, or
Difficulty), drag the Mouse down until the selection is highlighted,
then release the Mouse button.

Most of the Menu Bar selections can also be made without the
Mouse, by holding down the right Amiga key (A) while typing the
corresponding letter Oust type A S to Save a game, for example).

To turn the sound OFF a'nd ON, use the monitor's volume control.

PROJECT
There are five selections in the Project Menu.

About just shows a brief note about the game programmer.
Load Position (A L) lets you load anew game or apreviously
saved game.
To load a new game, select START-POSITION, then click on LOAD.
START-POSITION is the starting point for a new game and is the
only game that can be loaded from the program disk.

To load apreviously-saved game, make sure your save-game
disk is in the drive before selecting LOAD POSITION.

Save Position (A S) lets you save a game in progress to a
save-game disk. Make sure the save-game disk is in the drive
before selecting SAVE POSITION. Then, type a name for the
game you're saving and click on SAVE.

Pause Game (A P) lets you temporarily halt game action and
time. When the game is paused, the prompt changes to read:
Continue Game (A P).

Quit Game (A L) takes you back to the Amiga's Workbe1ch
screen.

HELP
There are four selections in the Help Menu.
About Red October (A R) gives you a few facts about the
submarine.
Controlling Red October (A C) gives you abrief rundown of how
to pilot the boat.
Strategy Hints (A H) provides a few tips on gameplay.
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Recognition (A R) calls up the Ship Recognition Charts. When
you make this selection, you'll get a ++ and -- on-screen under
the ship icons. Click on the ++ and -~ to flip through the
Charts. Click CANCEL to go back to the game.

DIFFICULTY
You can change the difficulty level anytime during the game.
The three levels of challenge are: Easy (A E); Normal (A N)'
and Difficult (A 0). '

Rtarl 51
A Menu Bar lets you make gameplay selections with the Mouse
anytime during play. Press the right Mouse button to pause the
game and see the Menu Bar.

To make a selection from the Menu Bar, move the cursor over the
Menu you want (Desk, File, or Help), and slide the Mouse down until
your selection is highlighted. Then click the left Mouse button.

DESK
The only selection in the Desk Menu, About Red October, just
gives you the legal notices and game credits.

ALE
Anytime during the game you can load a new game, load a
previously-saved game, save the game in progress, or quit.

Load Position lets you load a new game or apreviously-saved
game.

To load a new game, select START.SAV, click OK, then select
CONTINUE GAME. START.SAV is the start position for a new
game and is the only game that can be loaded from the program
disk

To load a previously-saved game, make sure your save-game
disk is in the drive before selecting LOAD POSITION. Select the
name of the game you want to load, click OK, then select
CONTINUE GAME.

Save Position lets you save a game in progress to your save
game disk.

Make sure your save-game disk is in the drive before selecting
SAVE POSITION. Then, click on a blank line (or on an already
used line, if you want to save over another saved game), and
type a filename up to seven letters long (no need to type in .SAV,
as the game does that for you). Click OK and the game is
saved.
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Continue Game lets you continue playing where you left off
before the game was paused.

Quit lets you exit the game.

HELP
There are four selections in the Help Menu.

About Red October gives you a few facts about the submarine.

Controlling Red October gives you abrief rundown of how to
pilot the boat.

Strategy Hints provides a few tips on gameplay.

Recognition calls up the Ship Recognition Charts. When you .
make this selection, you'll get a + and - on-screen under the ship
icons. Click on the + and - to flip through the Charts. Press
EXIT to go back to the game.

Commodore 64/128
To get gameplay options on the Commodore, hold down the F1 key
for a few seconds, then release. This pauses the game and takes
you to a menu with five options.

LOAD FROM DISK
This lets you load a new or previously-saved game. When you
select LOAD FROM DISK, you'll see this list:

HFR01 HFR02
HFR03 HFR04
HFR05 HFR06
SELECT QUIT

To load a new game, click on HFR01 , then click on SELECT.
Now click on BACK TO GAME and the new game loads. HFR01 is
the start position for a new game and is the only game that can
be loaded from the program disk.

To load a previously-saved game, make sure your sav~-game
disk is in the drive before selecting LOAD FROM DISK. Click on the
game you wish to load, then click SELECT. Now click on BACK
TO GAME and the saved game loads.

SAVE TO DISK
This lets you save up to six games on asave-game disk. Make
sure the save-game disk is in the drive, then click on SAVE To
DISK. You'll see the same list you get when you select LOAD
FROM DISK. Click on the selection you wish to save the game to,
then click on SELECT, and the game is saved

6
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CHANGE DEVICE
Click here to change from a disk drive t.o a tape player. You can
use this to save games to a cassette tape instead of a disk.

RECOGNITION CHARTS
This lets you call up the Ship Recognition Charts. When you
make this selection, you'll get a NEXT and LAST on-screen under
the ship icons. Click on NEXT and LAST to flip through the
Charts. Press QUIT to go back to the game.

BACK TO GAME
This lets you continue playing where you left off before you
paused or saved the game.

MS-DOS Machines
Press ESC to pause the game and see the Menu that lets you make
game selections anytime during play.

To make a Menu selection, press the number key (on the keyboard,
not on the keypad!) corresponding to the Menu selection. You can
also use the Cursor Keys or the Joystick to move the cursor to a
Menu selection, then press the SPACEBAR or Joystick fire button.

1: CONTINUE GAME
Select 1 to continue playing where you left off before you paused
the game.

2: VIEW SCREEN
This lets you toggle between the Menu window and the game
screen while the game is paused. Type 2 to view the game
screen; press SPACEBAR to go back to the Menu. Press 1when
you're ready to continue playing.

3: LOAD POSITION
Press 3 to load a previously-saved game. You'll get a message
that tells you to insert a save-game disk and press fire. Insert
your save-game disk into the specified drive, press SPACEBAR or
the Joystick fire button, and you'll see a list of saved games.
Select the number corresponding to the game you want to load.

4: SAVE POSITION
Press 4 to save a game in progress to your save-game disk.
You'll get a message that tells you to insert a save-game disk
and press fire. Insert your save-game disk into the specified
drive, press SPACEBAR or the Joystick fire button, type a name
for the game you're saving, and press SPACEBAR or the fire
button again.
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Main Display Window
This area is where all Maps, periscope views, and Ship Recognition
Charts are displayed.

Message Window

This is the High Level Command Screen (its appearance is slightly
different on the C-64/128 version of the game). It features all the
elements you need to command the Red October.

Message Window
Text information appears in the Message Window. This includes
crew responses to orders, plus other information, including Sonar
contacts, Electronic Surveillance Monitor message interceptions,
damage control reports, etc.

Messages can be scrolled up and down by clicking on the up and down
arrows at the left of the window.
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5: CREDITS
Select 5 to see the legal notices and game credits.

6: ABOUT RED OCTOBER
Selection 6gives you a few facts about the submarine.

7: STRATEGY HINTS
Press 7 to get a few tips on gameplay.

8: CONTROLLING RO
Select 8 for a brief rundown of how to pilot the boat.

9: SHIP RECOGNITION
Press 9 to see the Ship Recognition Charts. When you make this
selection, you'll get a» and« on-screen under the ship icons.
Click on the » and« (or type 2 or 3) to flip through the
Charts. Click on CANCEL (or type 1) to go back to the game.

0: MOTOR NOISE
This gives you the choice to turn the engine sounds OFF or ON,
depending on whether or not you want to hear them while you
play.

-: CALIBRATE JOYSTICK
Press - to adjust a Joystick for use in the game. When you
make this selection, you'll get awindow giving you three choices:

1: CANCEL

2: CALIBRATE JOYSTICK

3: ENABLE JOYSTICK.

Select 3, the prompt changes to DISABLE JOYSTICK, and you can
only play using the keyboard.

Select 2 and you'll get a series of prompts for adjusting your
Joystick.

Select 1 to go back to the Menu.

=: QUIT GAME
Press = to exit the game and go back to DOS.



Main Control Panel
This panel allows instant control over the major navigational functions.

Click on this readout to change
the Depth settings on the Order
Execution Panel.

It's important to keep your Depth above the safe pressure leVel
of 400 meters and to be sure that the Depth is appropriate for
the seabed terrain.

This shows the exact compass
Heading. The direction the sub's
bow is pointing at any given

time is the Heading (the direction it needs to point to reach a
target is called the Bearing).

When you wish to be very precise in setting a new Heading, click
on the Heading readout so you can use the Order Execution
Panel to make changes.

DEPTH READOUT

operation over the Clock. Time speed automatically returns to
normal if anything else is in Sonar range.

C-64/128: The time and date readouts are in the same box.
Click on this box to toggle between the two. To speed up time,
click on the box and hold down the fire button until the screen
border turns gray. The border won't turn gray if you don't hold
the button down long enough OR if another ship is in Sonar range.

To slow back to normal, repeat this process until the screen
border is black. Time speed peed automatically returns to
normal if anything else is on the Sonar map.

Caution: It's dangerous to speed up the clock in areas where
navigation is complex; you run the risk of grounding and sinking
the Red October.

SPEED READOUT
This shows your current Speed
in knots. Clicking on this calls up

____ ................. the Order Execution Paonel so
you can change the Speed. If you set the Speed at 0 knots,
you're also giVing the order for total silence (used when trying to
avoid detection).

HEADING READOUT

J
SPEED INDICATOR

When you want to
change speed
quickly, double-click
on the area of this
gauge corresponding
to the speed level
you want. Click on
the left end to slow
down and the right
end to speed up;
each marker on the
gauge indicates 5
knots.

COMPASS
Double-elick on a
Compass heading to
change directions
quickly.

calendar

Speed Indicator

Depth Compass
Gauge

DEPTH GAUGE
When you want to change depth quickly, double-click on the area
of this gauge that corresponds to the depth you want. Click on
the top end to surface and the bottom end to dive; each marker
on the gauge indicates approximately 60-70 meters.

CLOCK/CALENDAR
This shows you the time of day and the date.

Amlgs, ST, IBM: Speed up the game time by holding down the
Mouse or Joystick button or SPACEBAR when the cursor is over
the Calendar. Slow down the game time by performing the same

The Message Window also doubles as the Sonar Information and Fire
Control System Window when you click on the box between the up
and down arrows. .

Information is a sub commander's lifeline. The data displayed in this
Window is vital for the success of your mission.
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CONTOUR DISPLAY CONTROLI . I Click on this to turn the Contour Map ON or
CO~TOUR OFF in the Main Display Window.

CONTOUR MAP WITH SONAR DISPLAY

SONAR DISPLAY CONTROLI ~AR I Click on this to turn the Sonar Map ON or OFF in
SO the Main Display Window.

SONAR MAP WITHOUT CONTOUR DISPLAY

12

ORDER EXECUTION PANEL
Once you've clicked on the Speed, Heading, or Depth Readout,
you can adjust the settings precisely in the Order Execution
Panel.

READOUT (050 KNOTS,
in the illustration)
This shows which
navigational function
you're adjusting and its
level at the time you
gave the order to make
achange.

DECREASE
Click here to decrease
the readout level.

INCREASE
Click here to increase the readout level.

Use the INCREASE and DECREASE commands together to
fine-tune the Red October's Speed, Heading, and Depth.

EXECUTE
After you've made changes to the Speed, Heading, or Depth,
click here to confirm them.

CANCEL
Click here to cancel the changes and go back to the settings
you had before entering the Order Execution Panel.

Sonor
Click on this icon to call up the sonar
function icons. Submarines operate with a
continuous "passive" sonar that gives
approximate details of targets and their
identity or bearing. This data requires
verification by visual sighting or by the use
of "active" sonar to gain an accurate fix.

C·64/128 Users: The SONAR icon is the first icon on the left in the
HIGH LEVEL COMMAND SCREEN.
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DISPLAY ACTIVE

Click on this icon to see the Hydrophonics
Window.

Click this icon for an Active Sonar signal
(there's a "pinginQ" sound when Active
Sonar is on). This gives an accurate
sonar picture for assessing targets.

Warning: Active Sonar tells the ships on
the receiving end of your signal that a
potentially hostile sub is near (and may

L............ give those ships a fix on your Bearing!).

Hydrophonics works best when the sub is
stopped. It won't work well if you are
using the Propeller Drive, since you'll keep
picking up your own engine noises.L.O.- --'"
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Click on this icon to get a small window
that shows you a cross-section of the
seabed. This Terrain Map is valuable in
that it can help you to avoid unpleasant
collisions with the ocean floor. Keep in
mind, when viewing the Map, that you
are seeing it as though you were outside

L..- --A the Red October.

Using the mini-icons to the right of the Terrain Map (at the top
of the Map on the C-64/128), the view can be alternated
between the sub's side and front and can also be magnified.

To get a side view,
click on the first icon.

Click on the second
icon for a front view.

Toggle between
magnified and normal
views with the last
two icons.

This photo is from the Amiga version of the game, but these
directions are the same for all computers.

H'PHONICS

TERRAIN

,~
C15P1AY

Info on aship represented by the letter R shows up in the
Sonar Information Window next to the letter R. Click on the
box between the up and down arrows at the left of the
Message Window to get the Sonar Information Window (click
on the box again to return to the regular Message Window).

The Bearing shows the direction from Red October to the
sonar contact; the Range is the distance in nautical miles.
Depth is shown if the contact vessel is another submarine.
The sonar contact's approximate Heading (the direction it's
going) and Speed in knots are also given.

This information is updated sonar. It may be necessary to
verify the data with visual sightings (use the periscope).

When there's a large number of sonar contacts on-screen,
the Sonar Information data can be scrolled up and down by
clicking on the up-and-down arrows at the left of the Window.
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Click on this icon to get an accurate
Contour Map of the sea bed. In this
Map, white shows the peaks of rock
formations; the darkest blue indicates
the seabed; the in-between shades of
color show the slopes of the terrain.

Note to IBM CGA users: The contour
effect is shown by shaded tones; thedarker the shading, the
deeper the sea.

CONTOUR/SONAR

I II I Click on either of these controls
CO~TOUR SO~AR to turn the Contour Map ON and

OFF. When the Contour Map is OFF, only the Sonar Map is
visible.

The Sonar Map shows all sonar contacts. Capital letters
indicate other vessels. Each contact is keyed and details of
the contact are shown in the Sonar Information Window:

t eal'
A:*278

• J): 307
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Propellers drive the boat faster than the
Caterpillar Drive does. When propellers
turn at high speed, they develop an area
of low pressure behind the trailing edge
of the blade. This low pressure area
collapses, water rushes forward against
the blade, and lots of noise results
(you're leaving a trail for hunters).

The Caterpillar Drive uses impellers
rather than propellers. The sub sucks
water in through the bow and the
impellers eject it from the stern, thereby
moving the boat very quietly, but also
very slowly.

EXIT
Click here to return to the previous level of icons.

PROPELLER DRIVE

CATERPILLAR DRIVE

Weapons

Click this icon to select the Red October's
propulsion method.

C-64/128 Users: This is the second icon
from the left at the bottom of the High Level
Command Screen.

Click on a target ship's
data (R, B, etc.) in the
Sonar Window to get a
picture of its sonar
signal in the Hydro
phonics Window (shown
at right). Use the up
and-down arrows to
match the target ship's
signal with one from
your library of signals.

EXIT
Click here to return to the previous level of icons.

Engines

NUCLEAR

Nuclear power gives you the fastest
speeds. However, after game day 12
(anywhere between days 10 and 13 on
the Commodore-64/128), the nuclear
power plant is shut down (this is part of
the defection plan).

Click on the Weapons icon to call up the
options for doing battle. Torpedoes are the
only weapons the Red October has at her
disposal. Use the Sonar Information Window
or the Attack Scope to select targets.

C-64/128 Users: This icon is askull-and-
L..- .....a.i crossbones.

TORPEDOES
DIESEL

Diesel power is noisier than nuclear; but,
after you lose the nuclear power plant,
diesel is all you have.

This icon shows the status of RO's four
torpedo tubes; 1and 2 are the forward
tubes, 3 and 4 are aft.

The first number shows which tube is
selected; the second number tells how
many torpedoes are in that tube. Click
on the icon to change tubes.

16 17
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Click on this icon to activate the periscope
options. You can only use the periscope
when at the proper depth (no more than 24
meters).

Note: Using the periscope makes it easier
for the Red October to be detected by other
ships.

SEARCH

Click on this to get a periscope view of
the horizon.

Click on the left and right arrows in the
Control Panel to rotate the Scope for a
better view of your surroundings.

C-64/128 Users: Smarks the Search
Scope.

With the periscope up, you get a Control Panel beneath the Main
Display:

A- Noise made by
the Red October;

B - Power left in the
sub's batteries;

C - Arrows for
rotating the Scope
left or right;

D- Periscope
Heading;

E- Air levels in the
compressor; R B

F· Incoming signals
(check Message Window);

LOCK· Button for locking onto target ships.

Scope

Click here to fire torpedoes. You can
launch one torpedo at a time from each
tube.

Note: This is noisy and can give away
your position.

This lets you lay electronic decoys to
deflect and confuse incoming enemy fire.
Of course, laying flak also creates noise
that can give away your position.

There is enough ammunition in your flak
stores for four uses of this decoy (eight
uses on the C-64/128).

The Manual Override bypasses
automatic control of torpedo launching
and lets you set the heading and
elevation of each torpedo. Don't set the
angle too steep, or the target might spot
your torpedo soon enough to take evasive
action.

MANUAL OVERRIDE

To change the
torpedo's Heading,
click on the arrOws
on either side of
the gauge; the
readout beneath
shows the exact
Headinp. Click on
the up-" d-down
arrows to change
the torpedo tube's
Elevation; the readout beneath shows the current angle.

FIRE

LAY FLACK

EXIT
Click here to return to the previous level of icons.

1~ 19
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BTTM

The Electronic Surveillance Monitor
(E. S. M.) allows interception of any
messages being transmitted between
ships. It updates you on fleet positions
on the Atlantic Map and may also give
useful info about enemy intentions during
the hunt or rendezvous.

Click here to use the latest image
intensification technology for visual
references at night.

If your Scope is up and the entire screen
is white, this means it's daytime and
your night enhancement is turned on!

Click on this icon to toggle between the
Atlantic Map (a view of the entire game
area) and the Contour Map.

This won't turn on the Contour Map if
you've turned it off from the Main Control
Panel using the CONTOUR/SONAR button.

EXIT
Click here to return to the previous level of icons.

C·64/128 Users: N marks the Night Scope.

E.S.M.

NIGHT

Mops

Click on the Attack Scope icon to see
the Attack Sights in the Main Display.

C·64/128 Users: A marks the Attack
Scope.

To use the Control Panel to lock onto a
target vessel, you must first have the

target in your sights (it doesn't have to be in the Sonar Informa
tion Window). If more than one ship is in your sights, you'll lock
onto the one closest to you.

PERISCOPE VIEW WITH ATTACK SIGHTS

Click on the LOCK button and the target ship's co-ordinates are
fed to the Fire Control System (check the Sonar Information
Window for this data). Select the Torpedoes and the current
Torpedo tube will have these co-ordinates.

Note: You lock onto co-ordinates, not ships! If you want to be
sure to hit the ship, you'll have to fire while it's still in the co
ordinates where you first sighted it.

ATTACK
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Euasion
Both U.S. and Soviet navies have sophisticated sensing devices.
There is a way to avoid these (or at least confuse them): sail
through obstacles which block the devices' sensors: rocks, ranges,
and reefs.

Note: The RO's hull is extremely sensitive so be careful not to run
into anything!

While stealth is vital, failure to make headway early will result in major
troubles. Fortunately, RO has an advantage over its rivals. The
Caterpillar Drive provides silent, virtually undetectable movement. The
drawback? Using the Caterpillar Drive reduces the RO's speed by two
thirds.

Extended use of the diesel back-up engines increases the need to surface
and recharge the batteries. This increases the risk of discovery.
Another risk is being attacked, an event which is quite likely.

And don't forget not to raise the suspicions of the crew. To journey too
far from the course outlined in the mission "orders" will cause concerned
questions from your navigation officer and, may result myour being
relieved of command (mutiny!). . .

Nauigation
Figuring out how to get from Iceland to the Eastern Seaboard of the
United States is your navigational challenge. Do you head directly
south, or do you go north, first, to throw your pursuers off track?
It's up to you.

The North Atlantic Map shows approximate positions of all fleets in
relation to the RO.

The Contour Map helps you negotiate the complex valleys of the
Reykjanes Ridge, the main route for Soviet Ballistic Missile subs
heading for the open Atlantic. This Ridge is where Red and US
attack subs constantly lurk.

You can superimpose the Sonar Map over the Contou(Map for a
mo,e complete picture of who's in the area. .

Using these three Maps together, you can plan the safest route to
your objective.

IOVERALL STRATEGY & TACTICS~ _ o ~~spite ~he RO's new hull design and anechoic (noise-absorbing) tiles,
It I~ not Immune from sonar (even with the Caterpillar Drive on).
Ships and aircraft carry sophisticated beacons that can findJhe
most sile~t sub. And these vessels, planes, and choppers are also
armed With the means of destroying whatever their sonar1ihds: .'~

Hint: Because of. the limitations of passive sonar, it's posSibl'S ~)iub
c?uld tr~ck RO Without your realizing it. How do you check for
silent tails? The "Crazy Ivan" is the best method. The Crazy Ivan
is a 360 0 turn which lets your passive sonar pick up on practically
anything within sonar range.

Under Rttack
Typical Anti-Submarine Warfare (ASW) engagements have several
stages.

First, the hunter seeks his quarry. It's likely that the search will be
confined to passive sensors, aided by satellite or seabed sensors.
Once contact is made, your sub's classification is determined. The
acoustic signature of the target (e.g" sub type, defense systems,
etc.) is compared with those in the hunter's data banks. The hunter
then moves into an attack position (within about six miles - roughly
half a torpedo's range).

If the attack is a success, you're sunk. If not, you can run for it,
play "possum," or return fire.

Usual Rttack Weapons
One of the oldest anti-sub weapons is the torpedo. Aircraft, surface
ships, and other subs carry these. The RO (or any other nuclear
sub) can outrun torpedos if there's enough time to react. Some
torpedos don't give much warning, however. These torpedoes are
delivered to the target via rocket-launchers. After parachuting into
the sea, these "fish" quickly home in on their targets.

You can use electronic decoys to fool torpedos. These simulate prop
and general sub noise and are towed about 400 yds behind. Hopefully
the torpedo will hit the decoy instead of you. '

A ri~kier, p~opostition is to head for the ,torpedo! This only works if
you re Within 1000 meters of the launching vessel. A fish doesn't'
have time to arm itself within that distance. Thus, if you ram it, it
won't explode.
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Another traditional anti-submarine weapon is the depth-charge.
They're very accurate! If you find yourself under depth charge
attack, take evasive action immediately (leave!).

Ship-launched missiles are another threat, though they're not as
accurate as torpedos and depth charges (unless, of course, you're on
the surface; in which case, you're a sitting duck). The best defense
against a missile attack is to dive deeper.
There is also danger from mines. The hydrophonics officer keeps
you posted of mine fields.
The threat from the air can be the most dangerous since aircraft
are hard for subs to detect or defend against. Jets, helicopters, and
prop planes carry plenty of search and destroy equipment.

On The Offensiue
RO's defenses are limited to four torpedo tubes. Her torpedo range
is 10-12 nautical miles, though chances of a hit are best at about six
miles. While acoustic torpedoes can be targeted via sonar bearings
from the Fire Control Computer, you can also carry out traditional
periscope-view assaults. If torpedoes are set for manual override,
you'll have to guesstimate the target vessel's course in relation to
the trajectory of the torpedo.
Hint: try a "noisy sprint" at the target, followed by a silent drift.
This may sneak the RO into a good strike position.
Note: If you attack a US ship, naturally, they'll sink you! If you fire
on the Soviets or they fire on you while you're in range of US
vessels, the US may join the Reds in aseek-and-destroy mission
against you, thinking you're a renegade ship with the potential for
instigating a nuclear war.

End of the Game
Whether the Red October is destroyed or you succeed in your
mission, you'll get a news report on your computer screen that lets
you know exactly what happened.

\This is a copy of only one page of the report; so, if you see a
.(continued page 3) note at the bottom of the page, don't be
concerned with it.
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Recognition Charts

Exit to Pro Dos (Quit)
Back To Game

Banery indicator

Contour Display In

the Main Display
Windcm. Click it
again to see the
Sonar Display

Time & Date

The game starts in demo mode. In this mode, the Red October
has a pre-plotted course and speed which it follows until it hits a
mine and sinks. To override the demo and begin a game, just
start giving orders via the keyboard, joystick, or mouse.

p y, or Torpedo Depth and
Heading Windows, depending
on what was last selected from
the options on the right (1-5) .

I I
DEPTH SPEED I 00:41 I06 DEC ICJ 11I1iiiJ1iI~ HEADING -
~0 MAIN SONAR

~ DISPLAY
WINDOW- - ENGINESBmB - Depth, Heading, & Speed fine-tune controls

0- _ Magnification factor read-out WEAPON

Ir - Magnify in or out by a factor of 4

CONTOUR I OPTIONS
SCOPE

[]] Periscope depth sir!

[IJ Sonar Contact Bearing
242 degrees sir!

IT] Sonar data locked in MAPS

This window always shows the Press Contour once Red October Options:
Terrain Map, Hydrophone to call up the Save 1 Save 2 Save 3

-Dis la

Apple 128K Hunt For Red October Addendum

If you're using an Apple 128K to play The Hunt For Red October,
please read the manual for game information. Even though the
manual doesn't specifically mention the Apple 128K, it's pertinent to
your computer with only a few differences. These differences are:

The Main Display Window (Page 9 of the manual) looks like this
on the 128K version. New "fine-tune" controls have been added.
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3 You may use cursor keys, a mouse, or a joystick for gameplay.
When the game loads, hit a cursor key to use the cursor keys;
click the mouse button to use the mouse; or press the firebutton to
use the joystick. To use a different gameplay option (eg, the
mouse instead of the joystick), reload the game, then make your
selection.

4 If you're using the keyboard, the arrow keys direct the RO and
number keys 1-5 select the options shown to the right of the Main
Display Window (sonar, engines, etc.). If you're using the mouse,
click the mouse button to accept commands. If you're using a
joystick, press the firebutton to accept commands.

5 To accelerate game time (about twice as fast), .!:lQ.k!~ the
closed Apple.

6 There is no "Ping" sound when you use sonar. The word "Ping"
appears in the message window.

7 The fifth time you hit the ocean floor, you're sunk.

8 Battery power is always visible as a read-out next to the battery
icon above the Main Display Window. When the read-out is
completely green, you're fully charged. When it's completely red,
you need to surface and recharge the batteries.

9 You don't need to double-click on the depth, heading, or speed
gauges for commands to be accepted. One click will suffice.

10 There are fine-tune controls for depth, heading, and speed
located directly under the respective gauges. Adjustments are
made in real time. Depth adjustments are by multiples of 10
meters; heading adjustments are by multiples of 11; and speed
adjustments are by multiples of 1 knot.

11 There's a Terrain Map magnification read-out (1-4) in a window at
the lower left of the Main Display Window. You can zoom in or out
using the controls beneath the read-out. These zoom controls
can only be used when the Terrain Map is displayed.

12 The 128K Apple has eight flack decoys instead of just four.

13 At the end of the game, you see the complete newspaper article
concerning the RO. All other versions merely give you an excerpt.

IMPORTANT!!!

To start The Hunt for Red October
on your Apple IIe. IIe or IIc+, boot

the back (unlabeled) side of the
program disk.


